WAGO Software

2759-0101
Quickstart reference for the software e!COCKPIT

Version 2.5.0
Every conceivable measure has been taken to ensure the accuracy and completeness of this documentation. However, as errors can never be fully excluded, we always appreciate any information or suggestions for improving the documentation.

E-Mail: documentation@wago.com

We wish to point out that the software and hardware terms as well as the trademarks of companies used and/or mentioned in the present manual are generally protected by trademark or patent.

WAGO is a registered trademark of WAGO Verwaltungsgesellschaft mbH.
# Table of Contents

1  Notes about this Documentation .................................................................5  
1.1 Scope of Validity ......................................................................................6  
1.2 Copyright ..................................................................................................6  
1.3 Property rights ........................................................................................7  
1.4 Symbols ...................................................................................................8  
1.5 Number Notation ....................................................................................10  
1.6 Font Conventions ...................................................................................10  
2  Important Notes ........................................................................................11  
2.1 Legal Bases ...........................................................................................11  
2.1.1 Subject to Changes ...........................................................................11  
2.1.2 Personnel Qualification .....................................................................11  
2.2 Safety Advice (Precautions) ...................................................................12  
3  Overview ....................................................................................................13  
4  Requirements ............................................................................................15  
4.1 System Requirements ............................................................................15  
4.2 Licenses ..................................................................................................16  
4.2.1 Engineering Licenses ........................................................................16  
4.2.2 Runtime Licenses ..............................................................................17  
5  Installing ....................................................................................................20  
5.1 Installing e!COCKPIT .............................................................................20  
6  Starting ......................................................................................................21  
6.1 Starting e!COCKPIT ...............................................................................21  
6.2 Purchasing a License .............................................................................22  
6.3 Activating the License ............................................................................22  
6.4 Activating Automatic Updates ...............................................................24  
7  Overview of the User Interface ................................................................25  
8  Operating ...................................................................................................28  
8.1 Creating a New Project ..........................................................................28  
8.2 Configuration and Parameterization ......................................................29  
8.2.1 Offline Configuration ........................................................................29  
8.2.1.1 Adding Devices in the Project .......................................................29  
8.2.2 Online Configuration ........................................................................30  
8.2.2.1 Scanning the Network and Devices ............................................30  
8.2.2.1.1 Adjust communication settings ................................................30  
8.2.2.1.2 Starting the scan operation ......................................................31  
8.3 Addressing Inputs/Outputs ......................................................................37  
8.4 Creating a Simple Program ....................................................................38  
8.5 Example: Creating a Simple Modbus Network ......................................39  
9  The PFC200 Controller .............................................................................45  
9.1 Checking the Firmware Version of the PFC200 Controller ....................45  
9.2 Updating the PFC200 Controller Firmware ...........................................47  
9.3 Entering Settings for the PFC200 Controller .........................................49
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.3.1 Obtaining an IP Address via DHCP</td>
<td>49</td>
</tr>
<tr>
<td>9.3.2 Setting a Fixed IP Address</td>
<td>49</td>
</tr>
<tr>
<td>9.3.3 Entering ETHERNET Settings</td>
<td>50</td>
</tr>
<tr>
<td>9.3.4 Access via Web-Based-Management (WBM)</td>
<td>51</td>
</tr>
<tr>
<td>9.3.5 Opening a Serial Port Connection</td>
<td>56</td>
</tr>
<tr>
<td>9.3.6 Establishing an ETHERNET Connection</td>
<td>57</td>
</tr>
<tr>
<td>9.3.7 Selecting the Runtime Environment</td>
<td>57</td>
</tr>
</tbody>
</table>

List of Figures .................................................................................................... 59

List of Tables....................................................................................................... 61
1 Notes about this Documentation

Note
Always retain this documentation!
This documentation is part of the product. Therefore, retain the documentation during the entire service life of the product. Pass on the documentation to any subsequent user. In addition, ensure that any supplement to this documentation is included, if necessary.

Note
Note about working with this documentation!
Please read the “Overview” section, it is an introduction to the software and provides a general description of functions. The following sections describe program installation and launch. Next, familiarize yourself with the eCOCKPIT graphical user interface. The subsequent sections contain operating instructions for using the software.
1.1 Scope of Validity

This documentation applies to the “e!COCKPIT” software version 1.6.0.

**Note**

Observe other applicable documentation!
Besides this Quick Start Guide, observe additional instructions and information provided in the operating instructions for the software and devices used. Download the operating instructions for the e!COCKPIT software and PFC200 used from the website [http://www.wago.com](http://www.wago.com).

1.2 Copyright

This Manual, including all figures and illustrations, is copyright-protected. Any further use of this Manual by third parties that violate pertinent copyright provisions is prohibited. Reproduction, translation, electronic and phototechnical filing/archiving (e.g., photocopying) as well as any amendments require the written consent of WAGO Kontakttechnik GmbH & Co. KG, Minden, Germany. Non-observance will involve the right to assert damage claims.
1.3 Property rights

Third-party trademarks are used in this documentation. This section contains the trademarks used. The “®” and “TM” symbols are omitted hereinafter.

- Adobe® and Acrobat® are registered trademarks of Adobe Systems Inc.
- AS-Interface® is a registered trademark of AS-International Association.
- BACnet® is a registered trademark of American Society of Heating, Refrigerating and Air Conditioning Engineers, Inc. (ASHRAE).
- Bluetooth® is a registered trademark of the Bluetooth SIG, Inc.
- CiA® and CANopen® are registered trademarks of CAN in AUTOMATION – International Users and Manufacturers Group e. V.
- DALI is a registered trademark of Digital Illumination Interface Alliance (DiiA).
- EtherCAT® is a registered trademark and patented technology of Beckhoff Automation GmbH.
- EtherNet/IP™ is a registered trademark of Open DeviceNet Vendor Association, Inc (ODVA).
- EnOcean® is a registered trademark of EnOcean GmbH.
- IO-Link is a registered trademark of PROFIBUS Nutzerorganisation e.V.
- KNX® is a registered trademark of KNX Association cvba.
- Linux® is a registered trademark of Linus Torvalds.
- LON® is a registered trademark of Echelon Corporation.
- Modbus® is a registered trademark of Schneider Electric, licensed to the Modbus Organization, Inc.
- PROFIBUS® is a registered trademark of Siemens AG.
- PROFINET® is a registered trademark of Siemens AG.
- Subversion® is a registered trademark of Apache Software Foundation.
- Windows® is a registered trademark of Microsoft Corporation.
1.4 Symbols

**DANGER**

Personal Injury!
Indicates a high-risk, imminently hazardous situation which, if not avoided, will result in death or serious injury.

**DANGER**

Personal Injury Caused by Electric Current!
Indicates a high-risk, imminently hazardous situation which, if not avoided, will result in death or serious injury.

**WARNING**

Personal Injury!
Indicates a moderate-risk, potentially hazardous situation which, if not avoided, could result in death or serious injury.

**CAUTION**

Personal Injury!
Indicates a low-risk, potentially hazardous situation which, if not avoided, may result in minor or moderate injury.

**NOTICE**

Damage to Property!
Indicates a potentially hazardous situation which, if not avoided, may result in damage to property.

**NOTICE**

Damage to Property Caused by Electrostatic Discharge (ESD)!
Indicates a potentially hazardous situation which, if not avoided, may result in damage to property.

**Note**

Important Note!
Indicates a potential malfunction which, if not avoided, however, will not result in damage to property.
Information

Additional Information:
Refers to additional information which is not an integral part of this documentation (e.g., the Internet).
1.5 Number Notation

Table 1: Number Notation

<table>
<thead>
<tr>
<th>Number Code</th>
<th>Example</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>100</td>
<td>Normal notation</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>0x64</td>
<td>C notation</td>
</tr>
<tr>
<td>Binary</td>
<td>'100'</td>
<td>In quotation marks, nibble separated with dots (.).</td>
</tr>
<tr>
<td></td>
<td>'0110.0100'</td>
<td></td>
</tr>
</tbody>
</table>

1.6 Font Conventions

Table 2: Font Conventions

<table>
<thead>
<tr>
<th>Font Type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>italic</td>
<td>Names of paths and data files are marked in italic-type. e.g.: C:\Program Files\WAGO Software</td>
</tr>
<tr>
<td>Menu</td>
<td>Menu items are marked in bold letters. e.g.: Save</td>
</tr>
<tr>
<td>&gt;</td>
<td>A greater-than sign between two names means the selection of a menu item from a menu. e.g.: File &gt; New</td>
</tr>
<tr>
<td>Input</td>
<td>Designation of input or optional fields are marked in bold letters, e.g.: Start of measurement range</td>
</tr>
<tr>
<td>&quot;Value&quot;</td>
<td>Input or selective values are marked in inverted commas. e.g.: Enter the value “4 mA” under Start of measurement range.</td>
</tr>
<tr>
<td>[Button]</td>
<td>Pushbuttons in dialog boxes are marked with bold letters in square brackets. e.g.: [Input]</td>
</tr>
<tr>
<td>[Key]</td>
<td>Keys are marked with bold letters in square brackets. e.g.: [F5]</td>
</tr>
</tbody>
</table>
2 Important Notes

This section describes the legal principles and system requirements for using the software in compliance with intended purpose, underlying provisions and stated specifications.

2.1 Legal Bases

2.1.1 Subject to Changes

WAGO Kontakttechnik GmbH & Co. KG reserves the right to provide for any alterations or modifications. WAGO Kontakttechnik GmbH & Co. KG owns all rights arising from the granting of patents or from the legal protection of utility patents. Third-party products are always mentioned without any reference to patent rights. Thus, the existence of such rights cannot be excluded.

2.1.2 Personnel Qualification

Any steps related to the use of WAGO software may only be performed by qualified employees with sufficient knowledge of handling the respective PC system used.

Steps in which files are created or changed on the PC system may only be performed by qualified employees with sufficient knowledge in the administration of the PC system used in addition to the aforementioned.

Steps in which the behavior of the PC system in a network is changed may only be performed by qualified employees with sufficient knowledge in the administration of the network used in addition to the aforementioned.
2.2 Safety Advice (Precautions)

**Note**

Use up-to-date security software!
Secure operation of the PC system can be at risk as a result of malware such as viruses and Trojans, as well as related threats such as denial-of-service attacks. Therefore, make sure that the latest security software and definitions are always installed on the PC system.

---

**Information**

Disable or uninstall software that is no longer required!
The vulnerability of a PC system against malware and related threats increases with the number of installed or active software components (applications and services). Therefore, uninstall or disable software components that are not needed for the purpose at hand.

---

**Note**

Check the runtime system if access problems occur!
To access devices from e!COCKPIT, e!RUNTIME must be set in your device as the runtime system. In the event of access problems, check the device settings with your tool (hardware dependent) or from the Web-based management system.

---

**Note**

Adjust the screen resolution if necessary!
The CODESYS programming environment in e!COCKPIT is optimized for a screen resolution of 96 DPI. If editors are displayed out of focus, you may be using a different resolution. To adjust the resolution:

1. Right-click on the desktop.
2. Click Customize.
3. Click Display.
4. Select “100%”.

---
3 Overview

**e!COCKPIT** is an integrated development environment with seamless data retention for all automation tasks:

- **Hardware configuration and parameterization**

Hardware component configuration is an essential element of automation applications. All devices are configured so that the controller software produces optimum results during runtime. Controllers, fieldbus couplers/controllers, modules, input and output devices, as well as their communication relations can be configured.

Integrated configurators assist with device and network configuration using standard operating procedures: For example, it is possible to arrange devices in the project via Drag & Drop, use Copy & Paste to quickly multiply individual devices or entire network branches, or set parameter values for multiple devices simultaneously.

Besides the organization of devices in a tree structure, **e!COCKPIT** also enables the graphical display of a network topology – in the Network view – as a display form. This makes it possible to monitor complex interrelationships between devices and their current statuses. The network topology is likewise used for configuring different communication protocols. **e!COCKPIT** simplifies connecting controllers to fieldbuses.

Fieldbus-specific device description files (e.g., EDS), device drivers and libraries allow systems from other suppliers to be integrated into the topology along with WAGO devices. As such, the software has information on device specifications, i.e., device data or supported functions.

- **Programming with integrated e!RUNTIME**

**e!COCKPIT** integrates the **e!RUNTIME** programming software that is based on CODESYS V3. This enables software development in the standard IEC 61131-3 programming languages: Structured text (ST), ladder diagram (LD), function block diagram (FBD), sequential function chart (SFC) and “Continuous Function Chart” (CFC). For flexibility, all programming languages can be combined with one another. Created programs can be checked easily via simulations on the development PC. Existing programs can be reused and further developed.

- **Visualization (operation and monitoring)**

**e!COCKPIT** uses Drag & Drop to streamline user interfaces for the operation and visualization of a plant. The integrated visualization editor offers direct access to the program's variables in order to simulate the human machine interface (HMI) and PLC program on the PC. Using Unicode and the latest standards, such as HTML 5 or CSS, also prevents dependency on particular languages and target systems.
• **Diagnostics for target-oriented development and commissioning**

Whether in the office for development or at the machine for commissioning: Knowing the current, detailed status of the automation network is vital in order to obtain, audit and enable rapid fault localization and debugging. **eiCOCKPIT** offers powerful diagnostic options for this purpose: Error messages are displayed immediately. Through the structured wiring test function, erroneous wiring can be systematically identified.

• **Other useful functions**

**eiCOCKPIT** comes with an extensive range of IEC libraries. The software also offers several convenience functions, such as automatic updates, context-sensitive menus or user-defined workspaces.

---

**Note**

References to the **eiRUNTIME** programming environment!

Setting options in **eiCOCKPIT** resulting from the integrated **eiRUNTIME** and CODESYS programming environment are described in the online help feature. Opening the online help in **eiCOCKPIT** will also display the CODESYS documentation in the tree view next to the **eiCOCKPIT** documentation. Individual setting windows or names within the CODESYS documentation may differ from how they are shown in **eiCOCKPIT**.
4 Requirements

4.1 System Requirements

Minimum System Requirements

Table 3: Minimum System Requirements

<table>
<thead>
<tr>
<th>Components</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 7/8</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB</td>
</tr>
<tr>
<td>Free hard disk storage</td>
<td>6 GB</td>
</tr>
<tr>
<td>Processor</td>
<td>Dualcore CPU</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1,366 x 768 Pixel</td>
</tr>
</tbody>
</table>

Recommended System Requirements

Table 4: Recommended System Requirements

<table>
<thead>
<tr>
<th>Components</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows 7/8/10 x64</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB</td>
</tr>
<tr>
<td>Free hard disk storage</td>
<td>10 GB</td>
</tr>
<tr>
<td>Processor</td>
<td>Quadcore CPU</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1,920 x 1,080 Pixel</td>
</tr>
</tbody>
</table>

Requirements for using a PFC200

Table 5: Requirements for using a PFC200

<table>
<thead>
<tr>
<th>Firmware Version</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>040x0x</td>
<td>This controller can be operated without any firmware update.</td>
</tr>
<tr>
<td>030x0x</td>
<td>Before operation, this controller has to be updated with a new firmware.</td>
</tr>
</tbody>
</table>

Note

PFC200 must have a firmware version > 3!
To configure in eCOCKPIT your PFC200 must have a manufacturing firmware version >3. For this note the marking on the housing (see Section “The PFC200 Controller” > “Checking the Version of the PFC200 Controller”). Devices that are marked with firmware version 01 or 02 are not eCOCKPIT-compatible. In this case, perform a firmware update (see Section “Updating Firmware for a PFC200 Controller”).
4.2 **Licenses**

**e!COCKPIT** software is protected by licensing mechanisms. Licensing of other software products can also be managed in **e!COCKPIT**, e.g., **e!COCKPIT** add-ons and functions in controllers or WAGO touch panels (Runtime licenses).

For productive, unlimited software usage, a license is required. The software can also be used fully without a license key for 30 days. This trial period only includes the days of actual use. When loading the software, a prompt appears with the number of days remaining. Access without a license key is not possible after the trial period.

Depending on the type of software license, an Internet connection may be required for activation. Please refer to your license certificate for the corresponding information.

For **e!COCKPIT**, the following license types are relevant and available at WAGO: Engineering licenses (for PC software) and runtime licenses (for device functions).

### 4.2.1 Engineering Licenses

These licenses apply to PC software with engineering features, such as **e!COCKPIT**. The licenses make functions available and remain on the PC.

The following licensing models are used for engineering licenses:

- **Single license**
  1 license key for 1 PC

- **Workstation license**
  2 license keys for 2 PCs (e.g. PC and laptop)

- **Multi-user license**
  5/10/15/20 license keys for 10/15/20 PCs

- **Site license**
  1 license key; installations on an unlimited number of PCs at one company location

- **Buyout license**
  1 license key; allows installation on an unlimited number of PCs within a company. In addition, the software shall be used in the company's products that contain WAGO's automation components and thus form a functional unit (e.g. machines with integrated PC).

- **Starter kit license**
  1 license key for one PC; sale only in conjunction with hardware
• **OEM licenses**
  
  1 license key for configuring custom devices on any number of PCs

  An OEM license is a license purchased together with a custom device. The license can be activated on different PCs within *eCOCKPIT* to make custom devices accessible in addition to standard devices in the product catalog.

**Status for Engineering Licenses:**

<table>
<thead>
<tr>
<th>License Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked</td>
<td>The license is transferred and linked to a PC. An Internet connection is required to activate the license in the following.</td>
</tr>
<tr>
<td>Activated</td>
<td>The information on license use is transferred to WAGO Kontakttechnik GmbH &amp; Co. KG. Depending on the license model, an activated license is linked to one or more PCs (see description of the licensing modules in this section).</td>
</tr>
</tbody>
</table>

4.2.2 **Runtime Licenses**

Runtime licenses activate device functions (e.g., for fee-based libraries or bus systems). Using *eCOCKPIT*, the license can be transferred to a device and remains on the device. The following license models are used for runtime licenses:

The following license models are used for runtime licenses:

- **Single license**
  
  1 license key for 1 device function

- **Point license**
  
  In contrast to a single license, a point license can be used to cover the entire licensing requirement for several functions. Each function is rated with a specific number of points. The points for required functions are added together to determine the total licensing requirement for a device and displayed (tooltip in the “Project Licensing” control panel). When ordering, the device licenses are combined to the extent possible. A common license key is then used to activate all combined functions.
## Status for runtime licenses:

Table 7: Status for Runtime Licenses

<table>
<thead>
<tr>
<th>License Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>The license key is already entered in the e!COCKPIT license manager, but the license has not been assigned to a device. The license is displayed in the “Available licenses” control panel.</td>
</tr>
<tr>
<td>Assigned</td>
<td>License that has already been assigned to a device (e.g., by drag &amp; drop from the “Available licenses” control panel to a device on the network/device view or to a device in the “Project licensing” control panel. The license has not yet been loaded on the device.</td>
</tr>
<tr>
<td>Linked</td>
<td>The license has been assigned to a device and loaded on the device via synchronization.</td>
</tr>
<tr>
<td>Activated</td>
<td>The license has been saved (linked) to the device, activated using the license key and information on license use transferred to WAGO Kontakttechnik GmbH &amp; Co. KG.</td>
</tr>
<tr>
<td>Unbind</td>
<td>The license has been marked to unbind. The link is deactivated after the next synchronization operation and the license is displayed again in the “Available Licenses” control panel.</td>
</tr>
</tbody>
</table>

---

**Note**

**A point license is not available on different devices!**
If you purchase a point license, you can only load the associated points as a whole on one device. It is not possible to distribute the point on multiple devices. However, multiple point licenses can be used to purchase a device function.

---

**Note**

**Only use the license key according to license conditions!**
Do not use your license key outside the limits of your license model, otherwise you will be breaking the license agreement, which may have legal consequences.
Information

Additional information
The license requirement is displayed in the “Project Licensing” control panel (Ribbon > “VIEW” tab > [Project Licensing]).
In addition, the license requirement is displayed at other places in the e!COCKPIT interface indicated by a yellow warning triangle, e.g., in front of the respective device in the “Device structure” control panel or in the graphic or tabular network view. In addition, you are notified of the license requirement in the message window when compiling a project.

Information

Additional information
- The description for activating a license key for e!COCKPIT itself is available in the Section “Start”.
- Activating add-ons is described in the Section “Enabling Licensed Add-ons”.
- Activating additional device functions (runtime licenses) is described in Section “Activating Runtime Licenses”.
- The description of the “Available licenses” and “Project Licensing” control panels is also available in the same sections.
5 Installing

*e!COCKPIT* software is installed from a setup file. This contains a CODESYS programming environment, the .NET Framework and communication drivers for WAGO 750 Series devices. The device description files (Device Type Packages) for WAGO 750 Series devices are also automatically imported.

5.1 Installing *e!COCKPIT*

1. Open the *e!COCKPIT Website*.

2. To receive a download link for the *e!COCKPIT* software, click the [Registration] link and complete the form.

3. Download the software.

4. Start the installation process by double-clicking the setup file and follow the steps described in the Installation Wizard:
   - Select the installation language.
   - Accept the license agreement.
   - Select the target directory for installation.

5. Click [Install] to start the installation.

If an older version is already installed, a dialog appears in which you can choose to accept already installed devices.

---

**Information**

Show information about the new version!
During setup, you can click the [See What's New] button to open a PDF with current information about the version installed. You can also view the document via Backstage View > “Help” page > [Links] > *e!COCKPIT* Documentation” or at the *e!COCKPIT* website.

6. Click [Finish] to complete installation.
6 Starting

6.1 Starting e!COCKPIT

1. Launch e!COCKPIT via Start > Programs > “WAGO Software” > “e!COCKPIT” or via the link on your desktop.

Note

Continue setup after restarting PC!
After installation, e!COCKPIT is usually restarted automatically.
If installation of e!COCKPIT is not completed, restart e!COCKPIT.
If e!COCKPIT is still not available, launch the setup again.
If e!COCKPIT crashes the first time you launch it, restart your PC. This can happen if .NET Framework is not installed or an older version is installed on your PC.
If you start e!COCKPIT again, use administrator rights.

A start screen will be displayed while the software is loaded.

If you have already purchased and activated a license, the lower area of this screen will display the name under which your e!COCKPIT application is registered.

If you have not yet acquired a license, you can see the remaining time on the start screen.

Figure 1: Display of the Start Screen during Loading

This also opens a dialog via which you can purchase/activate a license (see the following section).

Figure 2: Display of the License Status
2. To test eCOCKPIT without entering a license key, click [Continue evaluation].

6.2 Purchasing a License

1. If you wish to purchase a license, click [Purchase license] after launching the software.

You will be taken to a Website where you can place the order (Online catalogue/eShop).

6.3 Activating the License

When purchasing the software via WAGO Kontakttechnik GmbH & Co. KG, the license key will be sent to you by email or phone.

1. To enter a purchased license key and activate the license, click [Enter license].

---

**Note**

Pay attention to exact spelling!

Depending on your selected license, an Internet connection may be required for entering and activating the license. Licenses that do not require an Internet connection for activation require the entry of the customer name. Ensure that you enter your customer name exactly as it is written in the email that you received when purchasing the software.

2. Enter your license key and, if necessary, your customer name in the dialog.

![Figure 3: Entering the License Key](image)

3. Accept the WAGO SOFTWARE LICENSE AGREEMENT and confirm that you are using the software for commercial purposes only.

4. To activate the license, click [Add licenses].

If the software has already been launched, open this dialog in the Backstage view: “Licensing” page, [License Manager], [Enter licenses].
Figure 4: Entering Licenses

This creates the license and is displayed in the license manager.

**Note**

**Open an Internet connection to activate licenses!**

Ensure that an Internet connection is established before you enter a license. The Internet connection is required for checking the validity of a license and for activation.

The license is also checked and activated if you tick the “Check for update and license information when starting **e!COCKPIT**” checkbox in Backstage view, “Help” > [Update].
6.4 Activating Automatic Updates

After the program is launched, the “Automatic updates” dialog is displayed.

![Automatic updates dialog](image)

Figure 5: Activating Automatic Updates

1. To automatically search for updates when the program launches, click [Yes].

If you choose [No], you can enable the Update function later: In the Backstage view ("FILE" tab) “Updates & Add-ons” page, tick the “Check for update and license information when starting eCOCKPIT” checkbox (Internet connection required on starting the program).

The update process compares your license information with the records of WAGO Kontakttechnik GmbH & Co. KG.

For additional information on performing updates, see the Section “Operation” > “Setting and Managing” > “Performing Software Updates”.
7 Overview of the User Interface

The graphical user interface contains three different views:

The Start View is displayed when the program starts. Here, for example, templates can be selected.

The Backstage View is opened via the "FILE" tab. It is used to set general options and settings for file handling.

The Main View is used for configuration, parameterization and programming of the devices. It contains a quick access toolbar (1), a menu ribbon (2), a workspace (3) and a status bar (4).

The workspace (3) is divided into the main workspace (by default in the middle) and panels that can be arranged freely. The panels can be shown or hidden via the "VIEW" tab depending on the application and specific operation. Panels are used to display and/or edit project or other data.
Workspace and panels for the network and device configuration, parameterization or programming can be opened parallel to each other and used. Depending on the selection, the different workspaces are synchronized. You can also create and save your own workspaces (tab "HOME" > button [Manage] > Create new workspace).

The “Network/Devices” view in the main workspace provides the following alternative display forms:

- Tabular view
• Graphical view

Figure 9: Graphical Network View

The corresponding buttons in the upper part of the main workspace can be used to switch between the views.

Figure 10: Toggling Between Graphical and Tabular View
8 Operating

This section describes software operation through its stages and typical workflows.

8.1 Creating a New Project

1. Launch e!COCKPIT.

2. Select a template in the Start view, e.g., “Empty Project.”

This creates a project. The main view is opened.
8.2 Configuration and Parameterization

8.2.1 Offline Configuration

In offline configuration mode, you configure the devices and network first without connecting to real devices. The configuration is saved and transferred at a later time.

8.2.1.1 Adding Devices in the Project

If there are imported devices in the Product Catalog, they can be used as follows:

- To add devices to a project, drag the individual devices (in this example, a PFC200) from the Product Catalog and drop them onto a free tile in Network view.
  
  To place devices on a free tile automatically, double-click the device name.

![Figure 12: Dragging Devices to the Network View](image)

- To insert a device several times click the Add symbol next to the device name. In the opened window enter the number of devices you wish to insert and click [Add].

![Figure 13: Adding Several Identical Devices](image)

- Open the Device Detail view by double-clicking an appropriate tile. Drag the modules from the product catalog to any position after the head station.
This will display a [+] next to the mouse pointer. Positioning lines between existing modules indicate at what point the module will be placed when you release the mouse button. Alternatively, the module can also be added by double-clicking it from the Product Catalog behind the currently selected module or at the last location.

The Device detail view only allows the configuration of one head station with connected modules.

### 8.2.2 Online Configuration

In online configuration mode, you are physically connected to your devices in the network via e!COCKPIT. The configuration can be transferred directly.

Click the [Connect] button to connect to available devices directly or perform a network scan first.

#### 8.2.2.1 Scanning the Network and Devices

To display devices present in the network, scan the network first:

1. Click [Network/Devices] in the device/program structure.
2. Open the “NETWORK” tab.
3. If the Network view does not appear in the workspace, click the [Network] button in the menu ribbon.

#### 8.2.2.1.1 Adjust communication settings

1. First check the communication settings by selecting from the selection field in the “Scan Settings” group the medium in which the search will be performed, such as ETHERNET.
2. Click [Settings] to make other settings.

3. For instance, restrict the scan range for the ETHERNET settings.

4. Click [Accept].

8.2.2.1.2 Starting the scan operation

The scan results can be displayed in tabular or graphical format in both the Communication and Topology view. This depends on the view in which you start the scan. However, you can switch between views via the respective selection fields/tabs at any time, even during the scan.

Tip

The **graphical view** uses colored tiles to give you an initial overview of what differences there are between your project and the scan results. Among other things, the Communication view displays differences for the modules used and the Topology view also displays physical connection differences.

The **tabular view** is used to display other details of those differences in list form, e.g., a comparison of different I/O modules between project and scan in the Communication view or details on connections and device ports used in the Topology view. In the tabular view, differences are displayed in color similar to the graphical view.

In the following example, you first start the scan in the graphical view of the Communication view.
1. To start the device scan in the network, click the [Scan] button in the “NETWORK” tab.

![Figure 18: Starting the Scan Operation](image)

The Scan view and “SCAN” tab of the menu ribbon open. Devices are searched.

Scanned devices are displayed below any already configured devices.

![Figure 19: Configured and Scanned Devices](image)

The scan results highlight in color whether it is a new (blue), changed (orange), unknown (red) or unchanged (gray) device.

**Your device is shown in gray:**

The scanned device matches the configuration.

1. Click the [Close scan results] button.

**Your device is shown in blue:**

The device is new and can be applied in the configuration.

1. Select the checkbox of the device or devices you want to apply.

The tile color changes from blue to gray.
2. Click the [Accept selection] or [Accept all] button in the “Scan” tab of the menu ribbon.

**Your device is shown in red:**

The scanned device is new and unknown. There is no device description file; the device is not available in the product catalog. This can happen, for example, with custom devices. Contact Support to obtain a device description for your device.

---

**Note**

*Use compatible device description!*

Please note that “dtp” file types are always permanently installed and cannot be imported.

**Your device is shown in orange:**

There are differences in the configuration.

1. Move the mouse over the device tile to display ToolTips with information on configuration differences.
2. If you want to apply the scanned device despite configuration differences, select the checkbox for the respective device. Notice: You overwrite the configured device by applying the scan results.

3. Click the [Accept selection] or [Accept all] button in the “SCAN” tab of the menu ribbon.

The Scan view is closed. The configured devices are displayed.

Below you will scan the I/O modules connected to the device.

---

**Note**

Scan head stations and I/O modules separately or together!

You can also scan head stations directly, including the connected I/O modules, by clicking the small triangle next to the [Accept selection] and [Accept all] on [Selection incl. modules] or [All incl. modules].

In this example, you have first selected only the head stations to be applied. You detect I/O modules separately in the next steps.

10. Select one of the scanned devices and click [Scan modules] in the “DEVICE” tab.

Alternatively, select [Scan] in the device context menu.

If the device is not connected, a connection is established automatically. The I/O modules are then detected.

If you have run the module scan for multiple devices, differences are initially displayed within the tiles.

![Figure 22: Configuration Differences for I/O Modules Used](image)

In this case, switch to the tabular view for a more detailed overview.

If you have run the module scan for one device, elCOCKPIT automatically switches to the tabular view.
Figure 23: Switching to the Tabular Scan View

The tabular view shows configuration and scan results. All modules that are connected to the device are displayed on the right and their device description files are loaded in COCKPIT. There can be selection fields for certain I/O modules. This happens because a device description file can represent multiple I/O modules if the I/O modules have the same process data structure. A detected I/O module may also be represented by multiple device description files.

Figure 24: Selecting I/O Modules

4. Select the I/O modules from the selection fields that you use in the node. If you make no selection, the pre-selected, generic I/O modules are used.

5. If there are multiple I/O modules with the same scan results in a node, the “Use for all suitable modules” checkbox is displayed in the selection field. Select the checkbox to apply the selection for all suitable I/O modules at the same time.

6. Select the checkbox before the scanned I/O modules that you want to apply to the configuration.

The colored marking of the rows goes away.

Figure 25: Selecting I/O Modules

7. Click [Accept selection]. Click [Accept all] to apply all I/O modules.

The Scan view is closed. The overview of configured devices is displayed.

You see the number of I/O modules applied at the bottom of the device tile.
The Device Detail view shows the head station with the scanned I/O modules.

Figure 26: Display of Applied I/O Modules

Figure 27: Displaying Scanned Modules
8.3 Addressing Inputs/Outputs

As a CODESYS V3-based system, COCKPIT does not have information for the fixed addressing of inputs and outputs customary with CODESYS V2.

Variable names must be assigned to inputs and outputs.

In the Device view, select a module to which you wish to assign variables and enter the variable names in the table underneath it.

Figure 28: Selecting a Module and Assigning Variable Names
8.4 Creating a Simple Program

1. Open the “Program Structure” panel.

2. Double-click “PLC_PRG” to open the program editor.

3. Write your program.

4. To select preconfigured I/O variables in the active program editor, press [F2] for the Input Assistant.

5. Open the context menu of the application (right-click on “Application”).

6. First click [Connect] and then [Start].
8.5 **Example: Creating a Simple Modbus Network**

Besides parameterization of individual devices, you can also design complete networks via **eCOCKPIT**. Select devices from the product catalog, drag them to a Network view, use connectors to connect the devices to each other, assign communication protocols and roles (master/slave) and configure the connection.

1. Select two devices from the Product Catalog and drag them with the mouse into the Network view.

![Figure 33: Dragging Devices to the Network View](image)

2. To change the settings or parameters of the devices added, click the respective device, open the “Settings” panel in the context menu and make your changes there.

![Figure 34: Opening the “Settings” Panel](image)

3. Now connect the devices. Click the gray connector (ETHERNET/Modbus) for one of the devices in the Network view and hold down the mouse button.

4. To connect the devices to each other, drag the connection line to the same type connector of the second device. Release the mouse button as soon as a green plus sign appears.

![Figure 35: Establishing Network Connections](image)

The devices are connected. The role of the device defines the connection direction. The connection direction is indicated by an arrow and goes from master to slave.
You can change the master and slave device roles later as needed.

5. Click the Modbus connector of one or both devices.

6. Click **[Communication Relation]** in the context menu.

![Figure 36: Select Communication Relationship](image)

The current communication relationship is highlighted in blue and displayed first.

7. Select the second entry as needed.
   
   In this example, you retain the communication relationship.

You can also specify the connection protocol.

8. Click the **[Protocol]** button in the context menu of the Modbus connector.
9. Select the required connection.
   In this example, select “MODBUS (TCP)”. The choices depend on the devices used.
   If your device can be used as a router for off-network devices, “Port forwarding” can also be selected (see Section “Connecting Off-Network Devices (Port Forwarding)”).

   You have defined the role of the device and the protocol used for the connection. Below you open the Modbus data point configurator. Use the data point configurator to define what slave variables should be available on the master.

10. To open the Modbus data point configurator for the connection, double-click on the device tile of the slave device in the Network view (Communication view).

   The Device Detail view appears. The Modbus data point configurator opens in the “Modbus slave” tab.

   The figure below shoes the Modbus data point configurator after opening. No communication variables between the master and slave have been defined yet.

   To create variables, right-click “PLC variables”.

   Click the [Add] button in the context menu.
Figure 39: Creating a New Variable on the Slave

The variable has been created as a global variable in the slave application and can be used there.

The table row displays the default values for Modbus access to the new variable.

3. To change the default values, double-click the individual fields “Direction”, “Variable”, “Data type”, etc.

4. To make settings regarding the Modbus address, right-click on the row of the newly created variable.

5. In the context menu, click [Edit] and adjust the settings as needed.

Additional Information

You can also create “Generic data points” in the same way as “PLC variables”. The [Edit] button is used for generic data points and Modbus special registers to open a dialog with further setting options, e.g., for setting function codes. Generic data points and Modbus special registers are not available via the slave application: Modbus special registers are only available in the Modbus stack of the slave and accessible via Modbus only. There are application cases in which it makes sense to use generic data points. For example, you can group multiple data points into one register to access different masters without having to create manual channels for every access in the master.

6. Go back to the Network view.

Below you open the Modbus fieldbus configurator. Mainly connection settings are made here, Modbus master variables displayed and created.

7. Click the Modbus connector of one or both connected devices.

8. Open the Modbus fieldbus configurator by clicking the button [Configurator].
The Modbus fieldbus configurator for the master opens. The configurator is divided into two columns:

The variables on the master are displayed on the left. The variables available on the slave and used in the slave application are displayed on the right. The tree displays them in a hierarchical view according to the program structure.

9. Select the slave variable created in the right column.

10. Click [Map] in the context menu of the variable.

![Figure 41: Creating a New Variable on the Master](image)

According to the path (namespace) in the slave application, the created slave variable is generated in the master application. It is then available on the master directly.

The variable created on the master (1), the variable on the slave (2), the selection field for the data type (3), the cycle time for updating the variables via Modbus (4) and Modbus access to the variables (5) are displayed.

ReadOnly (RO): Master reads the slave output.
WriteOnly (WO): Master writes to the slave input.
ReadWrite (RW): Master reads the slave output or writes to the slave input.

![Figure 42: New Variable on the Master](image)

11. Open the “Programming” workspace and open the main program of the master.
In the master application, access to the “ModbusDataPoint” variable as shown in the following figure. Tip: Press the [F2] key to open the Input Assistant for easy variable selection.

In this way, a variable has been declared in the slave application, made accessible via Modbus and read in the master application.

**Note**

**Note on Modbus communication problems:**
Modbus communication problems may occur even if “Running” is indicated as the Modbus status. For example, variable values may remain at “zero”. Try disconnecting and reconnecting the Modbus slave. If the status indicator does not update and the Modbus server remains inaccessible, you can request further diagnostics via the library instance “FbModbusRemoteSlave” (also see the description of the instance in the library manager).
You can enter the instance with the input wizard [F2] > **Instance calls** > “IoConfig_Globals” > [device name] in the master’s application.
9 The PFC200 Controller

Checking the controller for compatibility and updating it (if necessary) is described below.

### Information

Additional Information
Please refer to your controller’s manual for additional information.

### 9.1 Checking the Firmware Version of the PFC200 Controller

The PFC200 controllers need the e!RUNTIME runtime environment to interact with the e!COCKPIT software. This runtime environment is currently not yet part of the controller. Depending on the update status of the controller, it is possible to update it with the included firmware. The steps to determine if your controller is compatible with e!COCKPIT are described below.

### Note

Controllers with an update status from February 2015 can be updated!

PFC200 controllers manufactured before February 2015 with firmware version 01 or 02 cannot be updated.

You can identify the date of manufacture and the firmware version at the time of delivery via the marking on the service flap.

The PFC200 controller is e!COCKPIT-capable if the date of manufacture is 26.02.2015 (0915) or later and is marked as version 030101 or higher.

<table>
<thead>
<tr>
<th>Marking</th>
<th>Example</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>XXXXXXXXXXXX</td>
<td></td>
<td>Internal use</td>
</tr>
<tr>
<td>WWJJ</td>
<td>0915</td>
<td>Week and year of manufacture</td>
</tr>
<tr>
<td>FwHwFL</td>
<td>030101</td>
<td>Firmware, hardware and firmware loader</td>
</tr>
<tr>
<td>H1Hn…</td>
<td></td>
<td>Internal use</td>
</tr>
</tbody>
</table>
The same information is located on the side marking of the controller as shown in the figure below.

**Example:**

A printed manufacturing number 101503030107040415 means:

- **101503030107040415:** produced in week 10/2015
- **101503030107040415:** produced ex works with firmware version 03.
9.2 Updating the PFC200 Controller Firmware

The software installation package of e!COCKPIT also includes the current firmware for WAGO devices. Firmware versions are available in the following directories:

- PFC100, PFC200: „02_e!RUNTIME\PFC“
- Touch Panel 600: „02_e!RUNTIME\TP“

To import the firmware into the controller, you need an SD card and a tool that saves the firmware file to the SD card. A freeware tool example is “Win32 Disk Imager.” The subsequent steps are based on the use of this freeware tool.

---

**Note**

Use a suitable tool for copying the firmware!

Use a tool such as “Win32 Disk Imager” to write the firmware file to the memory card. You cannot simply copy the file.


---

**Note**

Select the correct memory card for the firmware update!

Ensure that you use the right memory card for the firmware update, especially when other external storage devices such as a USB memory are connected to your computer. The information on the target memory is then overwritten.

---

**Note**

Specific rights required for the firmware update!

Because the tools need specific rights for the firmware update, user permissions are queried via the user account control when starting the tool. If necessary start the software by right-clicking the program and selecting “Run as administrator.”

1. Start “Win32 Disk Imager” and select under “Image File” the firmware file “*.img” that you wish to write to the SD card.
2. Select the SD card under “Device.”
3. Click [Write] to write the firmware to the card.

The progress of the copy operation is displayed under “Progress.”

4. Click [Exit] to close the program.
5. Switch off the controller.

6. Take the memory card out of the PC or the card reader and insert it into the controller.

7. Switch on the controller.

The controller boots up from the memory card.

---

**Note**

**Firmware update also executable via Web-Based Management!**

You can also load the firmware image in the internal memory of the controller. Use the Web-Based Management (WBM) for this.

Find the appropriate command on the WBM page “Administration” > “Create Image.”
9.3 Enter Settings for the PFC200 Controller

There are various options described below for entering settings on the controller.

9.3.1 Obtaining an IP Address via DHCP

Within the controller’s factory settings, dynamic assignment of the IP address is set for the ETHERNET interface (port X1 and port X2) using “Dynamic Host Configuration Protocol” (DHCP).

9.3.2 Setting a Fixed IP Address

If you are not running any DHCP server on your network, set the IP address manually to reach the controller via ETHERNET. The X1 ETHERNET interface of the controller can be set on the controller to the fixed address “192.168.1.17.”

1. Set the operating mode switch to the STOP position (middle position).

![Figure 48: Setting the Operating Mode Switch to the STOP Position](image)

2. Press the Reset button (RST) with a suitable tool for at least 8 seconds.

![Figure 49: Pressing the Reset Button](image)

The saving of the IP address is indicated by the “SYS” LED flashing orange. The controller can now be accessed via the fixed IP address “192.168.1.17.” This IP address is valid until the next restart.

You can access the Web-Based Management of the controller via the fixed address and make settings.

The previous IP setting is restored after a restart.

---

**Information**

**Additional Information**

Please refer to the controller manual for other options to permanently change the IP address.
9.3.3 Entering ETHERNET Settings

1. Drag a controller from the Product Catalog onto a free tile in the Network view.

2. Open the “Settings” panel (“VIEW” tab > [Settings]).

3. Select the controller.

4. In the first tab of the “Settings” panel set the serial interface used or the IP address (fixed IP address: 192.168.1.17) when using the ETHERNET interface.

Figure 50: Entering the IP Address in the “Settings” Panel
9.3.4 Access via Web-Based-Management (WBM)

Additional settings can be entered on the controller via HTML pages inside the controller, the Web-Based Management (WBM). The fixed IP address “192.168.1.17” is used for the following example (see previous section).

1. Open a browser and enter “http://192.168.1.17” in the address line.

This opens the Web-Based Management.

A login must be completed in order to enter settings. Without a login the menu items are grayed out, and the mouse pointer appears accordingly above the disabled menu items.

2. Click the [Login] button at the top right of the window.

3. Enter “Username” and “Password.”
   Default:
   Username: admin
   Password: wago
Saving ETHERNET settings permanently

The settings for the ETHERNET interface can be saved permanently on the WBM page under “Networking” > “TCP/IP.”

Figure 51: Permanently Saving ETHERNET Settings
Activating/deactivating protocols

Activate/deactivate unencrypted protocols such as HTTP, FTP or Telnet on the WBM page “Ports and Services – Network Services.”

Figure 52: Activating/Deactivating Protocols
Activate/deactivate authentication for e!RUNTIME and web server

You can change the access data and password for e!RUNTIME at “Ports and Services” > “PLC Runtime Services” (“General Configuration”) or activate/deactivate them (“Port Authentication enabled”). This access data is required when you log into the device when programming in e!COCKPIT.

If you wish to use the web visualization, you can also activate the e!RUNTIME web server on this page (“Webserver enabled”). The web server is deactivated by default.

Figure 55: Activating/Deactivating Authentication for e!RUNTIME and Web Server
Web-Visu

The web visualization can be accessed at “PLC Runtime > Web-Visu” via the Open WebVisu in new window button or by entering: http://<IP Address>/webvisu/webvisu.htm.

Figure 53: Calling Web Visualization
9.3.5 Opening a Serial Port Connection

The serial port (also called WAGO Service Interface) is located under the service flap on the controller (this is not the RS 232-485 interface X3 on the controller).

You need a WAGO USB communication cable (750-923) to connect via the controller's WAGO service interface.

Additional Information

For more information about the WAGO communication cable (WAGO USB Service Cable) refer to the appropriate data sheet (http://www.wago.com > Search “750-923 Communication Cable”).

1. To set the controller in eCOCKPIT via the serial port, select the appropriate interface in the “NETWORK” tab.
9.3.6 Establishing an ETHERNET Connection

1. Open the “NETWORK” tab.
2. In the drop-down menu select the preferred connection. For the ETHERNET connection use a standard ETHERNET cable.

![Selecting the “ETHERNET” Interface](image)

9.3.7 Selecting the Runtime Environment

The runtime system can be set or changed via WAGO-ETHERNET Settings or via the Web-Based Management.

**Setting the runtime system via WAGO-ETHERNET Settings**

1. Click the [Settings] button in the first tab of the “Settings” panel.
2. This opens WAGO ETHERNET Settings.
3. The connection is established between WAGO-ETHERNET Settings and the controller. The “Identification” tab displays device data.

![Entering Settings](image)
4. Change the PLC runtime environment to the **e!RUNTIME** programming software used inside **e!COCKPIT**.

The runtime environment is set by default to “CODESYS V2.”

![Figure 52: Setting Runtime Environments (WAGO Ethernet Settings)](image)

**Setting the runtime system via Web-Based Management**

1. Open the Web-Based Management System.
2. Log in.
3. Open “PLC Runtime” > “General Configurations.”
4. Change the PLC runtime environment to the **e!RUNTIME** programming software used inside **e!COCKPIT**.

![Figure 53: Setting the Runtime Environment (WBM)](image)
List of Figures

Figure 1: Display of the Start Screen during Loading .......................................... 21
Figure 2: Display of the License Status ............................................................... 21
Figure 3: Entering the License Key .................................................................. 22
Figure 4: Entering Licenses .............................................................................. 23
Figure 5: Activating Automatic Updates ........................................................... 24
Figure 6: Main view .......................................................................................... 25
Figure 7: Panels ............................................................................................... 26
Figure 8: Tabular Network View ....................................................................... 26
Figure 9: Graphical Network View .................................................................... 27
Figure 10: Toggling Between Graphical and Tabular View ............................... 27
Figure 11: Selecting a Template ....................................................................... 28
Figure 12: Dragging Devices to the Network View ............................................ 29
Figure 13: Adding Several Identical Devices ..................................................... 29
Figure 14: Adding Modules .............................................................................. 30
Figure 15: Selecting the Medium for Scanning ................................................. 31
Figure 16: Restricting the Scan Range ............................................................... 31
Figure 17: Select Scan Views ............................................................................ 31
Figure 18: Starting the Scan Operation ............................................................. 32
Figure 19: Configured and Scanned Devices ..................................................... 32
Figure 20: Apply New Devices ......................................................................... 33
Figure 21: Display ToolTip for Configuration Differences ............................... 33
Figure 22: Configuration Differences for I/O Modules Used ............................. 34
Figure 23: Switching to the Tabular Scan View ................................................. 35
Figure 24: Selecting I/O Modules ..................................................................... 35
Figure 25: Selecting I/O Modules ..................................................................... 35
Figure 26: Display of Applied I/O Modules ...................................................... 36
Figure 27: Displaying Scanned Modules ............................................................ 36
Figure 28: Selecting a Module and Assigning Variable Names ......................... 37
Figure 29: Opening the “Program Structure” panel ......................................... 38
Figure 30: Opening the Program Editor ............................................................ 38
Figure 31: Opening Configured Variables in the Program Editor ...................... 38
Figure 32: Connecting and Starting an Application ......................................... 38
Figure 33: Dragging Devices to the Network View ............................................ 39
Figure 34: Opening the “Settings” Panel ............................................................ 39
Figure 35: Establishing Network Connections .................................................. 39
Figure 36: Select Communication Relationship ............................................... 40
Figure 37: Selecting protocol .......................................................................... 41
Figure 38: Modbus data point configurator ...................................................... 41
Figure 39: Creating a New Variable on the Slave .............................................. 42
Figure 40: New Variable on the Slave (Default Values) ..................................... 42
Figure 41: Creating a New Variable on the Master .......................................... 43
Figure 42: New Variable on the Master ............................................................. 43
Figure 43: Opening the Main Program of the Master ....................................... 44
Figure 44: Accessing the “ModbusDataPoint” Variable in the Master Application .................................................................................................................... 44
Figure 45: Marking Position ............................................................................ 46
Figure 46: Side Position of the Marking ........................................................... 46
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
<td>Win32 Disk Imager</td>
</tr>
<tr>
<td>48</td>
<td>Setting the Operating Mode Switch to the STOP Position</td>
</tr>
<tr>
<td>49</td>
<td>Pressing the Reset Button</td>
</tr>
<tr>
<td>50</td>
<td>Web-Based Management</td>
</tr>
<tr>
<td>51</td>
<td>Permanently Saving ETHERNET Settings</td>
</tr>
<tr>
<td>52</td>
<td>Activating/Deactivating Protocols</td>
</tr>
<tr>
<td>53</td>
<td>Calling Web Visualization</td>
</tr>
<tr>
<td>54</td>
<td>WAGO Service Interface</td>
</tr>
<tr>
<td>55</td>
<td>Selecting an Interface</td>
</tr>
<tr>
<td>56</td>
<td>Selecting the “ETHERNET” Interface</td>
</tr>
<tr>
<td>57</td>
<td>Entering Settings</td>
</tr>
</tbody>
</table>
List of Tables

Table 1: Number Notation.................................................................................... 10
Table 2: Font Conventions................................................................................... 10
Table 3: Minimum System Requirements ............................................................ 15
Table 4: Recommended System Requirements .................................................. 15
Table 5: Requirements for using a PFC200 ....................................................... 15
Table 6: Status for Engineering Licenses ............................................................ 17
Table 7: Status for Runtime Licenses ................................................................. 18
Table 8: PFC 200 Factory Marking..................................................................... 45